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1 Introduction 

1.1 General 
This document serves as a guide for developers of the Eclipse mdmbl project. It describes 
how to setup your environment, where the source code of existing projects can be found and 
retrieved, how the application can be built, deployed and how to start the application. 
 
Mailinglists: 

● For development communication we use the mdmbl mailing list: 
https://dev.eclipse.org/mailman/listinfo/mdmbl-dev 

● The openMDM Working group mailing list: 
https://dev.eclipse.org/mailman/listinfo/open-measured-data-wg 

 
For contributing to the mdmbl project you need to sign the ECA​ (Eclipse Contributor 
Agreement) : 
https://wiki.eclipse.org/ECA 
 
 
Helpful Links: 

●  Eclipse Wiki - openMDM EWG: 
https://wiki.eclipse.org/Open-Measured-Data-Management-WG 

● Eclipse Project openMDM@BL: 
https://projects.eclipse.org/projects/technology.mdmbl 

● Eclipse Bugzilla mdmbl issues: 
https://bugs.eclipse.org/bugs/buglist.cgi?quicksearch=openmdm&list_id=16180271 

● JIRA REQU Issues: 
https://openmdm.atlassian.net/secure/RapidBoard.jspa?rapidView=57&projectKey=R
EQU&view=planning&selectedIssue=REQU-48 

● openMDM git repos: ​http://git.eclipse.org/c/?q=mdm 
 
 
Note: this document is written in Google Docs, location: 
https://docs.google.com/document/d/1Cvu5cpm4fhlM_G4E1hdx7bT_XTATrvGRjCiBIAxcfQ8
/edit?usp=sharing 

1.2 Requirements and Bugs (JIRA and Bugzilla) 
Requirements​: 

● Requirements​ are created in the JIRA REQU project [1] 
● Requirements​ are ordered by priority and maturity by the Steering Committee 
● for every REQU issue one or more Eclipse Bugzilla issues [2] are created 

○ a comment with the link to the Bugzilla issue is added the the REQU issue 
○ the Bugzilla issue summaries follow the naming convention: 
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[REQU-xx] <summary> 
● mdmbl dev team works on the Bugzilla issues 

[1]​https://openmdm.atlassian.net/secure/RapidBoard.jspa?projectKey=REQU&rapidView=57
&view=planning 
[2] ​https://bugs.eclipse.org/bugs/buglist.cgi?quicksearch=mdmbl 
Bugzilla Bugs: 

● created from JIRA REQU issues: the Bugzilla issue summaries follow the naming 
convention: [REQU-xx] <summary>, a link back to JIRA is also provided in a 
comment 

● “real” bugs from internal or external 
● technical requirements / enhancements from the team 

1.3 Use of new Frameworks 
To introduce a new framework to the code the QA guidelines of the EWG and the Legal 
Process of Eclipse (​https://www.eclipse.org/legal/EclipseLegalProcessPoster.pdf​) has to be 
followed. 
 
Make a request the the Architecture Committee before you use the framework. The 
members of the AC are listed here: 
https://wiki.eclipse.org/Open-Measured-Data-Management-WG​. 
  

1.4 Branching and versioning 
This affects only the following projects: 

1. org.eclipse.mdm.api.base 
2. org.eclipse.mdm.api.default 
3. org.eclipse.mdm.api.odsadapter 
4. org.eclipse.mdm.nucleus 
5. org.eclipse.mdm.realms 

 
Stable versions are on the ​master​ branches. 
The current development happens on the ​dev​ branches. 
 
The latest stable version is the current master. Older stable versions are tagged with the 
version number, e.g. 0.6, 0.7, 0.8. These numbers refer to the releases in the openMDM 
JIRA: 
https://openmdm.atlassian.net/projects/REQU?selectedItem=com.atlassian.jira.jira-projects-
plugin:release-page&status=released-unreleased 
 
Also see the mdmbl download page:  
https://projects.eclipse.org/projects/technology.mdmbl/downloads 
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For each version since 0.7 find the build artefacts, documentation and release notes Git: 
http://git.eclipse.org/c/gerrit/mdmbl/org.eclipse.mdmbl.git/tree/Releases 
  
Note I: 
Only use code from the same version between the projects! There are breaking 
changes between the versions!  
 
Note II: 
All jar files that are build have the suffix *-1.0.0.jar - from all existing versions. This is 
unfavorable, it was introduced by the very first version. It will be changed latest with 
the official release 1.0 
 

1.5 Eclipse Infrastructure 

1.5.1 Gerrit 
The mdmbl project is using Gerrit for code reviews. To configure, refer to chapter ​4.4 
Configure Gerrit​.  
Gerrit has a two stage reviewing system:  

1. when code is checked into Gerrit, a build is automatically started. Ther Gerrit flag 
“verified” is set to +1, if the build succeeded 

2. a committer has to review the code and if ok, the code review flag is set to +2 
 

1.5.2 Jenkins 
https://ci.eclipse.org/mdmbl/ 
 
There a nightly builds for the dev and the master branches of the following projects: 

6. org.eclipse.mdm.api.base 
7. org.eclipse.mdm.api.default 
8. org.eclipse.mdm.api.odsadapter 
9. org.eclipse.mdm.nucleus 
10. org.eclipse.mdm.realms 

 
There are also builds for Gerrit and Sonar.  

1.5.3 Sonar 
The Eclipse SonarQube server is available via ​https://sonar.eclipse.org​. 
 
Static code analysis is configured for the dev branches of the following projects: 

1. org.eclipse.mdm.api.base 
2. org.eclipse.mdm.api.default 
3. org.eclipse.mdm.api.odsadapter 
4. org.eclipse.mdm.nucleus 
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5. org.eclipse.mdm.realms 
 
Generated and test sources are excluded. 

1.6 ODS Server used for Developer Tests 
All released versions are tested with the following ODS Server: 
 

● Peak Solution GmbH, Version 2.5.8
http://www.peak-solution.de/de/produkte-leistungen/versuchs-messdatenmanagemen
t/softwareloesungen/peak-ods-server/ 

● HiQSoft GmbH, Version 4.6: 
https://www.highqsoft.com/de/avalon-asam-ods-server/ 

 
NOTE​: There is an issue with the Avalon Server version 4.3b (from 2013):  if multiple catalog 
sensors are deleted, the server application throws an error and  and leaves the application 
model in a broken state. 
 
IMPORTANT NOTE:  
The Notification Service for the HighQ Avalon ODS Server is not working for version 
V.10. The Notification Service is only used for the full text search. 
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2 Prerequisites 
 
Already installed on your machine or install it: 
 

● Java 8: 
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.
html 

● Maven: ​https://maven.apache.org/ 
● Git: ​https://git-scm.com 

 
Test, if programs are available from a console: 

● > java -version 
● > mvn --version 
● > git --version 

If not, add the programs to your PATH variable or set corresponding *_HOME variables. 

3 Installations 

3.1 Gradle  
See ​https://gradle.org/install/​ for installation on you system. 
OR: 

●  Download Gradle from ​http://gradle.org/downloads 
● Unzip the file into a directory without spaces (recommended). 
● Create a GRADLE_HOME environment variable that points to this directory. 
● Adjust your PATH environment variable to include $GRADLE_HOME/bin 

(%GRADLE_HOME%\bin on Windows). 
● Test your setup by invoking `gradle --version`. 

3.2 Eclipse IDE 
 
Get the current JEE Distribution from  ​https://www.eclipse.org/downloads 
It is recommended to use the Eclipse Installer. 
Note: installation is tested with Eclipse Neon and Eclipse Oxygen 
 
Install Plugins: 

● Gradle: follow this tutorial ​http://www.vogella.com/tutorials/EclipseGradle/article.html​. 
Already included in the Eclipse Oxygen JEE Distribution 

● SonarLint via Eclipse Marketplace 
● EclEmma Code Coverage Tool (optional) 

 
Create a new workspace for the mdmbl projects and configure it: 
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● set encoding to UTF-8 
● set formatting rules to the Eclipse default rules 

 

3.3 Database for the User Preference Service 
The Preference service stores its data to a relational database. The database connection is 
looked up by JNDI and the JNDI name and other database relevant parameters are 
specified in src/main/resources/META-INF/persistence.xml. The default JNDI name for the 
JDBC resource is set to jdbc/openMDM.  
 
For the User Preference Service you need a database with a schema “openMDM”.  
Note: “openMDM” is the default schema name, it can be changed in the file:  
/org.eclipse.mdm.nucleus/org.eclipse.mdm.preferences/src/main/ 

resources/META-INF/persistence.xm ​l 

3.3.1 Apache Derby Database 
 
The Glassfish Application Server has included the Derby libraries, so first get the Glassfish, 
as described this ​chapter​. 
 
Create database and tables: 

● Change to your <glassfish_root> directory 
● Start the database:. 

<glassfish_root>$ ./glassfish/bin/asadmin start-database 

 
● Start the ij Tool (​http://db.apache.org/derby/papers/DerbyTut/ij_intro.html​): 

<glassfish_root>$ java -jar ./javadb/lib/derbyrun.jar ij  

 
● Create database with default name “openMDM” 

ij> CONNECT 

'jdbc:derby://localhost:1527/openMDM;create=true'; 

 
● Create the table “preference”  

ij> CREATE TABLE OPENMDM.PREFERENCE (ID BIGINT GENERATED BY 

DEFAULT AS IDENTITY NOT NULL, keyCol VARCHAR(255), SOURCE 

VARCHAR(255), username VARCHAR(255), valueCol 

CLOB(2147483647) NOT NULL, PRIMARY KEY (ID)); 
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● Add constraints  

ij> CREATE TABLE OPENMDM.PREFERENCE (ID BIGINT GENERATED BY 

DEFAULT AS IDENTITY NOT NULL, keyCol VARCHAR(255), SOURCE 

VARCHAR(255), username VARCHAR(255), valueCol 

CLOB(2147483647) NOT NULL, PRIMARY KEY (ID)); 

 

ij> ALTER TABLE OPENMDM.PREFERENCE ADD CONSTRAINT 

UNQ_PREFERENCE_0 UNIQUE (source, username, keyCol); 

 
● Check table: 

ij> SELECT * FROM OPENMDM.PREFERENCE; 

 

● close ij 

ij> exit; 

 
● Stop database. 

<glassfish_root>$ ./bin/asadmin stop-database 

 

3.3.2 Other Database Products 
There is also the possibility to use other database products. For Postgres DB you will find 
the according sql scripts after the nucleus build in the following directory: 
$workspace/org.eclipse.mdm.nucleus/build/distributions/schema/org.

eclipse.mdm.preferences 

 

Other database products supported by EclipseLink may also work, but are neither tested nor 
supported by the mdmbl project. 
 

3.4 Glassfish 
● Version 4.1.2 required 
● Download Glassfish from https://javaee.github.io/glassfish/download  
● Unzip the file into a directory without spaces (recommended). 
● Test it: 

○ change to the glassfish-root directory 
○ invoke `./glassfish/bin/asadmin start-domain` 
○ change to your browser 
○ URL localhost:8080 should show you a welcome page 
○ URL localhost:4848 should show you the admin page 
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○ Note: if you need to change the default ports 8080 or 4848 please see the 
glassfish documentation 

 
Refer to this ​chapter​ for patching glassfish, patches are necessary for 4.2.1.  
 
Not evaluated now for Glassfish 5.0.x. (2018-01-17). It seems to work without the patches, 
has to be tested some more. ​(TODO) 
 

3.4.1 Configure JDBC for the User Preference Service DB 
 
For the ​User Preference Sevice DB​ configure JDBC resource and its dependent JDBC 
Connection Pool. It has to be created and configured within the glassfish web administration 
console or through asadmin command line tool. 
 
Description for the Derby Database with defaultname “openMDM”: 

● Start Glassfish: `./glassfish/bin/asadmin start-domain` 
● Start Derby DB: `./glassfish/bin/asadmin start-database`  
● start: ​http://localhost:4848/ 
● Menu Item: JDBC-> JDBC Connection Pools -> new 

○ poolname: <mypool_name> 
○ Resource Type: javax.sql.DataSource 
○ Database Driver Vendor: Derby 
○ -> next 
○ set properties: User, Password, DatabaseName to openMDM 
○ -> finish 
○ check it: open Connection Pool, try the ping button 

● Menu item JDBC -> JDBC Resources -> new 
○ JNDI NAME: jdbc/openMDM 
○ Pool Name: <mypool_name> 

● stop glassfish `./glassfish/bin/asadmin stop-domain domain1` 
● stop Derby DB: `./glassfish/bin/asadmin stop-database` 

3.5 Database for ODS-Server 
The database product is dependent of the ODS Server you use. To start an ODS Server you 
need a loaded ASAM ODS Application Model in the DB. 

3.5.1 Embedded Apache Derby Database and Peak ODS Server 
If you use a Peak ODS Server from Peak Solutions GmbH:  
they provide an embedded demo Derby Database with an Application Model and Data. 
Follow their instructions. 
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3.5.2 Oracle 11g XE Release 2 
 

● Download it from 
http://www.oracle.com/technetwork/database/database-technologies/express-edition/
downloads/index.html 

● Install it. 
● Note for Ubuntu Users: see this article 

http://tuhrig.de/3-ways-of-installing-oracle-xe-11g-on-ubuntu/ 
● Note for Linux Users: Installing the Docker Container from 

https://hub.docker.com/r/alexeiled/docker-oracle-xe-11g/ 
 works fine (proofed by Angelika Wittek, 25.4.2017) 

 
Load an empty Application Model to the DB: please refer to Jira-Ticket ORGA-178 
TODO: check into git the dump and the descriptions and update link 
 

3.6 ODS Server 
ASAM ODS-Server e.g. from 

● Peak Solution: 
http://www.peak-solution.de/de/produkte-leistungen/versuchs-messdatenmanagemen
t/softwareloesungen/peak-ods-server/ 
Note: you also need the ​notification service plugin​ ​for Peak ODS Server 

● HiQSoft: 
https://www.highqsoft.com/de/avalon-asam-ods-server/ 

● or another compliant data source (e.g. PAK adapter) 
 

● Get a (test) license from the vendors and follow the installation instructions. 
● If you already imported an Application Model to your database and database is 

running, then the ODS Server should start. 
 
Notes for running a Peak ODS Server:  

● You need the notification service. Check if there is the 
notification-plugin-1.1.0.jar  
in the ​$odsserver_root/lib directory ​ or copy it there.  

● Configure parameters in ​$odsserver_root/cfg/server.properties: 
○ Add the following line to enable the notification service​: 

JMS_FORWARDER.PORT=8089 

○ The Peak ODS Server can run its own ORB daemon. Just leave the following 
parameter blank: ​NAMESERVICE=  

● Use the Peak demo Derby DB (MDMNVH DB) in embedded mode, the database 
starts automatically with the Peak ODS Server startup. 
Username and password are the name must be the name of the schema. 

○ DB_DRIVER = DERBY_EMBEDDED 
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○ DB_URL = 

jdbc:derby:/ ​<path_to_MDMNVH_DerbyDB>​/MDMNVH;create=false 
○ DB_USER = MDMNVH 

○ DB_PASSWORD = MDMNV 

3.7 ElasticSearch 
ElasticSearch can be downloaded at ​https://www.elastic.co/products/elasticsearch 
Use version 2.x., e.g. 
https://www.elastic.co/de/downloads/past-releases/elasticsearch-2-4-2 
 
Upgrade to version 5.x is planned, but it is not working yet, see: 
https://bugs.eclipse.org/bugs/show_bug.cgi?id=520297 
 
For testing purpose, it can be simply started by executing bin/run.bat 

4 Get and build the code 

4.1 Source Code Repositories 
The application is split into several modules, each one dedicated to a certain scope of 
functions. All source code has been made available in git repositories hosted by the Eclipse 
Foundation ​https://eclipse.org/org/foundation/ 
The version control system used to track all changes is Git: ​https://git-scm.com/ 
 
We strongly recommend to use a separate workspace for the openMDM projects. 
 

4.1.1 Manually checkout 
 

● Change to the workspace directory 
● Run the following command to checkout the source code. You have to adapt the URL 

for each project:  `git clone <repository URL>`  
 
Checkout the following projects 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.api.base.git 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.api.default.git 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.api.odsadapter.git 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.nucleus.git 
    git clone ​http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.realms.gi​t 
 
Additional tools: 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.openatfx.mdf.git 
    git clone http://git.eclipse.org/gitroot/mdmbl/org.eclipse.mdm.mdfsorter.git 
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4.1.2 Checkout in Eclipse IDE 
 
Alternatively configure eGit in your Eclipse IDE and checkout there.  

● Open the Git Perspective 
● Open “Clone a Git Repository ….” 
● Checkout with Username / Password:  

If you follow this way, the Git / Gerrit Configuration described in this ​chapter​  will be 
obsolete.  
https://<eclipse_username>@git.eclipse.org/r/a/mdmbl/<my_repo>, 
the passowrd is the Gerrit Password, look there: 
https://git.eclipse.org/r/#/settings/http-password 
 
e.g. ​https://awittek@git.eclipse.org/r/a/mdmbl/org.eclipse.mdm.api.base 

● Or anonymous with the URIs above. 
● Screenshot:

 
 
 

4.2 Importing projects to the Eclipse IDE 
Import the project to your Eclipse IDE via File -> Import -> Import as existing gradle project. 
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If importing all projects at once via the parent directory fails, import each project separately. 
Build the projects in the order they are listed above, because of the dependencies between 
them. 
Refer to the documentation and follow it: 

● http://git.eclipse.org/c/gerrit/mdmbl/org.eclipse.mdm.nucleus.git/tree/README.md 
● http://git.eclipse.org/c/gerrit/mdmbl/org.eclipse.mdm.realms.git/tree/README.md 

 
If there are still java errors after importing and building, right click on the project -> 
Gradle -> Refresh Gradle Project 
For other build problems. see the section ​4.4 Known setup bugs​. If your problem is 
not listed there, create a Bugzilla Bug for it: 
https://bugs.eclipse.org/bugs/enter_bug.cgi?product=MDMBL 
 
After importing the projects to the IDE, you have all repository connections in the Git 
perspective. 

4.3 Building the projects 

4.3.1 Building projects separately 
Run `./gradlew clean build` in the root directory of each project to build it. 
Execute `./gradlew clean build install` also generates a JAR to be placed in your local cache. 
From there it can be retrieved when subsequent projects are build.  
 
Or you build the projects in the Eclipse IDE via a Run Configuration: 

 
 
Please see the README.md files in the root directory of the projects for exact information 
about how the projects are build. 
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Note​: some projects depend on each other, so you have to build them in a specific order: 

1. org.eclipse.mdm.api.base 
2. org.eclipse.mdm.api.default 
3. org.eclipse.mdm.api.odsadapter 
4. org.eclipse.mdm.nucleus 
5. org.eclipse.mdm.realms 

 
The other projects can be built independently. 

4.3.2 Building all projects for the core application 
Running the gradlew script from org.eclipse.mdm.nucleus project will build the following 
projects: 

1. org.eclipse.mdm.api.base.git 
2. org.eclipse.mdm.api.default.git 
3. org.eclipse.mdm.api.odsadapter.git 
4. org.eclipse.mdm.nucleus.git 

 
You have to build the project org.eclipse.mdm.realms seperately. 

4.3.3 Building the projects without web frontend 
 
To build the application without the web frontend, pass the argument ​skipNode ​to the build 
script of the org.eclipse.mdm.nucleus project.  
> ​./gradlew clean build -PskipNode 
 

4.4 Configure Git and Gerrit  
For checking in code to a repository you need to configure Gerrit in the Git perspective. 
 
Additional informations: 

● Gerrit can be found at ​https://git.eclipse.org/r/ 
● There is a tutorial, it also explains how to use Gerrit with Eclipse: 

http://www.vogella.com/tutorials/Gerrit/article.html 
● See documentation from Eclipse: ​https://wiki.eclipse.org/Gerrit 

 
Prerequisites: 

● Get your Gerrit Password via: 
https://git.eclipse.org/r/#/settings/http-password 

● Configure your Gerrit settings: ​https://git.eclipse.org/r/#/settings/  
-> Watch the mdmbl projects. 
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4.4.1 Configure repositories 
Go to your Eclipse IDE -> Git Perspective: 
For all projects do: 

● Expand the project 
● Remotes -> origin ->  Select “Configure Push” from context menu ->  OK 
● URI -> click change button 
● Configure URI Window: 

○ URI: https://<eclipse_username>@git.eclipse.org/r/a/mdmbl/<projectname> 
e.g. 
https://<eclipse_username>@git.eclipse.org/r/a/mdmbl/org.eclipse.mdm.api.base 

○ Protocol: choose HTTPS 
○ Fill in username and password (the Gerrit one from the settings above) 
○ Check the option “Store in secure store” 

● Back to the “Configure Push” Window, section “Ref mapping” -> add 
○ Local Branch: HEAD 
○ Choose remote branch:  

■ for the dev branch e.g. refs/for/dev 
■ for the master branch: refs/heads/master 

○ OK 
● Try the “Dry-Run” Button to test your configuration 
● Save 
● “Gerrit Configuration” (right click on the remote) 

○ URI: same as above 
○ Username: same as above 
○ Destination branch: dev (or another) 

● Finish 
 

 

4.4.2 Configure Push 
To push code to Gerrit you can  

1) As a committer 
a) Push code directly to Gerrit without any review (in Git repositories view: Push 

to upstream) 
b) Push code to Gerrit for reviewing (in Git repositories view: Push to Gerrit) 

2) As a non-committer 
a) Push code to Gerrit for reviewing (in Git repositories view: Push to Gerrit) 

 

4.4.3 Commits to Gerrit 
 

● Add Signed-Off-By when you commit to sign off the commit 
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● In Eclipse: open the git staging perspective, there is a window called "Commit 
message" and next to the label "Commit Message" there are 3 buttons. the middle 
button is the "Add signed-off-by" button. Click it. 

5 Deploy and configure application 
before deploying the application: 

● start ORB (​$JAVA_HOME/bin/orbd -ORBInitialPort 2809 ​) (skip this if you 
are using Peak ODS Server with no NAMESERVICE specified in the 
server.properties) 

● start ODS Server with corresponding database 
● start Elasticsearch 
● start Glassfish 

○ > asadmin start-database 

○ > asadmin start-domain 

 
The build of the nucleus module creates: 
/org.eclipse.mdm.nucleus/build/distributions/mdm_web.zip  
 
The ZIP archive contains: 

●  the backend org.eclipse.mdm.nucleus.war 
● the configurations in /configuration 
● sql scripts for the User Preference Service in /schema.  

 
 
Configuration: 

● copy the content of the extracted /configuration folder to 
$​GLASSFISH_ROOT/domains/domain1/config 

● Configuration file: ​org.eclipse.mdm.property/ ​global.properties 
To enable globally the freetext search set the parameter: ​freetext.active=true 

● if you enable the freetext.active parameter (=true), make sure  
○ that ElasticSearch is started and that the port in the property 

elasticsearch.url ​is set correct (check it in the ElasticSearch log and 
via your browser with the url and port, the result should be a json response)  

○ the freetext parameters are set in the service.xml 
○ freetext search is active for at least one service 

● Configuration file: ​org.eclipse.mdm.connector/service.xml  
○ configure the data sources, for ODS Servers look into your ODS Server log 

file to determine the corba URL 
○ To use the freetext search configure for each datasource separately: 

■ specific parameters for the NotificationService and the freetext search 
■ set the freetext.active parameter to true (Example2) 

○ Disable the freetext search for a datasource: 
■ set the freetext.active parameter to false (Example3) 

or  
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■ leave away the freetext.* parameters, as they are optional (Example1) 
 

<services> 
<!-- Example1: ODS Server without freetext.* parameters -> freetext search is not active --> 
<service entityManagerFactoryClass="org.eclipse.mdm.api.odsadapter.ODSContextFactory"> 

<param name="nameservice">corbaloc::1.2@YOUR_HOST1:2809/NameService</param> 
<param name="servicename">YOUR_SERVICE1.ASAM-ODS</param> 

</service> 
<!-- Example2: Peak ODS-Sever with active freetext search --> 
<service entityManagerFactoryClass="org.eclipse.mdm.api.odsadapter.ODSContextFactory"> 

<param name="nameservice">corbaloc::1.2@YOUR_HOST2:2809/NameService</param> 
<param name="servicename">YOUR_SERVICE2.ASAM-ODS</param> 
<!--The indexing requires a user to get the DataItems from the ODS Server. Those are the 

credentials for the user --> 
<param name="freetext.active">​true​</param> <!--to configure the Avalon, set to false (*) --> 
<param name="freetext.user">sa</param> 
<param name="freetext.password">sa</param> 
<param name="freetext.notificationType">peak</param> 
<param name="freetext.notificationUrl">http://YOUR_HOST2:8089/api</param> 

</service> 
 
<!-- Example3:  Avalon ODS-Sever -> freetext search is not active--> 
<service entityManagerFactoryClass="org.eclipse.mdm.api.odsadapter.ODSContextFactory"> 

<param name="nameservice">corbaloc::1.2@YOUR_HOST3:2809/NameService</param> 
<param name="servicename">YOUR_SERVICE3.ASAM-ODS</param> 
<!--The indexing requires a user to get the DataItems from the ODS Server. Those are the 

credentials for the user --> 
<param name="freetext.active">​false​</param> <!--to configure the Avalon, set to true (*) --> 
<param name="freetext.user">sa</param> 
<param name="freetext.password">sa</param> 
<param name="freetext.notificationType">avalon</param> 
<param name="freetext.pollingInterval">5000</param> 

</service> 
</services> 

 

IMPORTANT NOTE:  
The Notification Service for the HighQ Avalon ODS Server is not working for version 
V.10. The Notification Service is only used for the full text search. 
 

 
● install and configure the LoginModule  (see org.eclipse.mdm.realms - README.md) 
● restart the application server 

 
Deploy the backend ( org.eclipse.mdm.nucleus.war) on your Glassfish server 
=> do it via the admin console at ​http://localhost:4848/ 
 

● goto  ​http://localhost:8080/org.eclipse.mdm.nucleus​ and Login with sa/sa 
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6 Start application 
 

● start ORB (​$JAVA_HOME/bin/orbd -ORBInitialPort 2809 ​)  (skip this if you 
are using Peak ODS Server with no NAMESERVICE specified in the 
server.properties) 

● start the database for the ODS Server (if necessary) 
● start the ODS server 
● start Elasticsearch 
● start Glassfish (including database for UPS)  

 
Change to your browser URL is http://localhost:8080/org.eclipse.mdm.nucleus. 
You should see the openMDM LoginPage. Look for user/ password in the database in the 
userXX table, e.g. sa/sa. 
 

7 Known (setup) problems and solutions 
 

7.1 Build 
● The build of the org.eclipse.mdm.api.odsadapter project does need a “gradle clean 

install” as a “gradle install” breaks with build errors that package 
“com.google.protobuf” does not exist  

7.2 Glassfish 

7.2.1 Glassfish - Inconsistent Module State 
● org.glassfish.deployment.common.DeploymentException: Error in 

linking security policy for org.eclipse.mdm.nucleus -- 

Inconsistent Module State 

○ Deployment went wrong 
■ delete 

$glassfish_root/glassfish/domains/domain1/applicat

ions/org.eclipsemdm.nucleus 

■ delete ​$glassfish_root/glassfish/domains/domain1/ 
generated 

■ restart Glassfish 
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7.2.2 Glassfish - java.lang.ClassNotFoundException 
 
If you run into "java.lang.ClassNotFoundException: 
javax.xml.parsers.ParserConfigurationException not found by org.eclipse.persistence.moxy" 
this is a bug described in ​https://bugs.eclipse.org/bugs/show_bug.cgi?id=463169 
 and ​https://java.net/jira/browse/GLASSFISH-21440​. 
 
This solution​ is to replace 
GLASSFISH_HOME/glassfish/modules/org.eclipse.persistence.moxy.jar with this: 
http://central.maven.org/maven2/org/eclipse/persistence/org.eclipse.persistence.moxy/2.6.1/
org.eclipse.persistence.moxy-2.6.1.jar 
 

7.2.3 Glassfish - org.osgi.framework.BundleException 
If you run into “org.osgi.framework.BundleException: Unresolved constraint in bundle 
com.fasterxml.jackson.module.jackson-module-jaxb-annotations”: this is a compatibility 
problem with the installed jackson libraries. 
The solution is to replace 
GLASSFISH_HOME/glassfish/modules/jackson-*.jar with these files:  

● http://central.maven.org/maven2/com/fasterxml/jackson/core/jackson-annotations/2.8
.1/jackson-annotations-2.8.1.jar 

● http://central.maven.org/maven2/com/fasterxml/jackson/core/jackson-core/2.8.1/jacks
on-core-2.8.1.jar 

● http://central.maven.org/maven2/com/fasterxml/jackson/core/jackson-databind/2.8.1/j
ackson-databind-2.8.1.jar 

● http://central.maven.org/maven2/com/fasterxml/jackson/jaxrs/jackson-jaxrs-base/2.8.
1/jackson-jaxrs-base-2.8.1.jar 

● http://central.maven.org/maven2/com/fasterxml/jackson/jaxrs/jackson-jaxrs-json-provi
der/2.8.1/jackson-jaxrs-json-provider-2.8.1.jar 

 
Rename the jars to the replaces (remove the versions). 

8 Extended configurations (run & IDE) 

8.1 Hot Deployment 
● On the command line run "gradlew clean install" in org.eclipse.mdm.nucleus 
● Eclipse setup: 
● Import all projects into Eclipse (tested with Buildship 2.2.x) 
● Import -> Gradle Project 

○ org.eclipse.mdm.nucleus 
● In project "org.eclipse.mdm.nucleus" 

○ Project Properties 
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■ Project Facets (if project is not faceted yet) 
● Convert to faceted form ... 
● Select "Dynamic Web Module" 

○ Builders (optional) 
■ Disable "Validation" (speeds up redeployment) 

○ Deployment Assembly 
■ Remove all entries 
■ Add following sources 

● To Deploy Path WEB-INF/lib 
○ Java Build Path Entries 

■ Add Project and External Dependencies 
○ Project 

■ org.eclipse.mdm.api.base 
■ org.eclipse.mdm.api.default 
■ org.eclipse.mdm.api.odsadapter 
■ org.eclipse.mdm.businessobjects 
■ org.eclipse.mdm.connector 
■ org.eclipse.mdm.filerelease 
■ org.eclipse.mdm.freetextindexer 
■ org.eclipse.mdm.preferences 
■ org.eclipse.mdm.property 

● To Deploy Path WEB-INF/classes 
○ Folder 

■ org.eclipse.mdm.application/bin 
● To Deploy Path / 

○ Folder 
■ org.eclipse.mdm.application/build/node/dist 

● To Deploy Path /WEB-INF 
○ Folder 

■ org.eclipse.mdm.application/src/main/webconfig 
   

● In projects 
○ org.eclipse.mdm.api.base 
○ org.eclipse.mdm.api.default 
○ org.eclipse.mdm.api.odsadapter 
○ org.eclipse.mdm.businessobjects 
○ org.eclipse.mdm.connector 
○ org.eclipse.mdm.filerelease 
○ org.eclipse.mdm.preferences 
○ org.eclipse.mdm.property 

 
○ Project Properties 

■ Project Facets 
● Set Java Version to 1.8 

● In project "org.eclipse.mdm.connector" 
○ Gradle -> Refresh Gradle Project 
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● Check that in project org.eclipse.mdm.nucleus the Deployment Assembly settings 

were not resetted. Otherwise redo. 
 

● Setup Glassfish (Servers View) 
○ Servers -> Create new 
○ Complete setup for local Glassfish instance 

■ Install Glassfish tools if needed 
(https://marketplace.eclipse.org/content/glassfish-tools) 

○ Double-click on Glassfish server 
■ Publishing 

● "Automatically publish when resources change" 
○ Context Menu -> Add and Remove ... 

■ Add org.eclipse.mdm.nucleus to Glassfish 
 

● Configure Glassfish 
○ Open Management Console (localhost:4848) 

■ Configurations 
● server-config 

○ System Properties 
■ Add property 

org.jboss.weld.serialization.beanIdentifierIndex
Optimization to false 

   
● Start Glassfish in "Debug"-Mode to have your changed sources published 

 

8.2 Angular Live Development Server 
During development a full build of the MDM5 Webclient, which is part of the nucleus, is quite 
time consuming. It is more efficient to skip the client build entirely by using the parameter 
-PskipNode, which excludes the JavaScript-Code from being build and included in the war 
file. For the UI you can start the "NG Live Development Server".  
It is started by invoking "npm start" in the root path of the angular application 
(org.eclipse.mdm.nucleus\org.eclipse.mdm.application\src\main\webapp). After successful 
compilation you are able to see the webclient under http://localhost:4200/. 
Changes to the angular application will trigger an incremental compile of the changed 
sources.  
Additionally the the live development server implements a proxy, which forwards all requests 
to http://localhost:4200/org.eclipse.mdm.nucleus/* to http://localhost:8080/. So if the 
Glassfish with the MDM5 backend does not run on port 8080, you have to change the proxy 
configuration in 
org.eclipse.mdm.nucleus/org.eclipse.mdm.application/src/main/webappproxies/development
.config.json.  
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To avoid issues with the form based authentication, it is easier to switch to basic 
authentication by changing the web.xml in this scenario. Otherwise you may get errors for 
the backend requests, because you are not automatically forwarded to the login page. 
 

8.3 SonarQube  
The Eclipse SonarQube server is available via ​https://sonar.eclipse.org​. 
 
Note: Do not use SonarLint plugin as the current version does not support the old 
SonarQube version at Eclipse and the old one has less features that the SonarQube plugin 
 

● Install SonarQube plugin version 3.5 
○ Install new Software… 

■ Add ​http://downloads.sonarsource.com/eclipse/eclipse/ 
■ Select all plugins to be installed 
■ Oxygen might complain about Erlang Configuration Helper to not be 

installable 
● Configure SonarQube in Eclipse: Eclipse Preferences -> SonarQube -> Servers 

○ Edit the default server or create a new one if none present 
■ SonarQube Server ID: Eclipse 
■ SonarQube Server URL: ​https://sonar.eclipse.org 
■ Username: your username for eclipse.org 
■ Password: your password for eclipse.org 

● Associate projects with Eclipse SonarQube:  
○ Edit Project Properties for all projects from 

■ org.eclipse.mdm.api.base 
■ org.eclipse.mdm.api.default 
■ org.eclipse.mdm.api.odsadapter 
■ org.eclipse.mdm.nucleus 
■ org.eclipse.mdm.realms 

● Configure 
■ Associate with SonarQube: Association should be proposed 

automatically 
●  Available Views are 

○ SonarQube Issues 
○ SonarQube Rule Description 

● Analysis can be performed via 
○ Project context menu 
○ SonarQube -> Analyze 
○ The results of the analysis are then written to Eclipse SonarQube 
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9 Development Rules 

9.1 Commit comments 
Prefix every commit with the Bugzilla ID if there is one, e.g. your commit message would be 
“518433: made some changes”. 
 

9.2 Tasks in the code 
TODO / FIXME and other tasks have to follow this naming  schema: 
 
// {TASK_NAME} {my_committer_id}, {yyyy-MM-dd}: {my_comment} 
 
e.g.  
// TODO mkoller, 2017-11-14: Currently only the first Adapter is 
indexed. 
 
You can do that manually or you can import the following snippet In the Eclipse IDE  via  
Preferences ->Java -> Editor -> Templates  
 
 
 

<!-- Import: Eclipse IDE -> Window -> Prefernces -> Java -> Editor Templates -> 

Import --><!-- User Variable: add to eclipse.ini -> "-Duser.name=<my name>" → 

<templates> 

        <template autoinsert="true" context="java" deleted="false" description="" 

enabled="true"        name="TODO">// TODO ${user}, ${d:date('yyyy-MM-dd')}:  

       </template> 

      <template autoinsert="true" context="java" deleted="false" description="" 

enabled="true" name="FIXME">// FIXME ${user}, ${d:date('yyyy-MM-dd')}: 

       </template> 

</templates> 

 

 
 
 
Usage in code: "TOD"+ [Ctrl+Space] 
 
You have to set your Eclipse user to your commiter ID: 
edit the file eclipse.ini and set the parameter: 
-Duser.name=your_eclipse_committer_id 
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9.3 Working with committer feature branches 
Develop on your committer feature branch. Make code reviews as usual via Gerrit on your 
branch. 
 
Committer feature branches have a special name scheme: 
${my_committer_id}/my_branch​.  
Only for those references under refs/heads (and refs/tags) with your Committer ID you will 
be able to delete the branch afterwards. 
 

● To create a branch: create the branch with the name scheme -> 
${my_committer_id}/my_branch 

● To delete a branch in Eclipse: Project → Team → Remote → Push … 
○ “Next” on first wizard screen 
○ Select branch to delete in “Add delete ref specification” 
○ Click “Add Spec” (the branch is now listed in “Specifications for push” 
○ “Finish” 

● When integrating your branch into the dev branch 
○ Checkout the dev branch 
○ Merge your feature branch into the dev branch, but with having Git a merge 

commit created although it was a fast-forward merge 
git merge --no-ff your_feature_branch 

○ Push the dev branch to Gerrit 
 

Note: Without the no-ff option Gerrit refuses to accept the push due to “no new changes”. 
 

10 Tipps+Tricks 

10.1 Handling of Relations 
● First, you should consider if you really need to access relations directly. For most use 

cases there already is a function in the OpenMDM 5 business logic available which 
does what is required.  

● The BaseEntityManager interface allows you to traverse parent and children 
relations. 

● If you need to read other relation types, you can implement and use a 
BaseEntitySearchQuery. For details look at the method changeRelation in 
org.eclipse.mdm.api.odsadapter.RelationTest. 

● For setting relations you need to access to BaseEntityFactory.get*Store. Typically 
this is only possible for the adapter implementation, because the contents of the 
stores might not be 100% consistent over different adapters. The adapter may 
choose make these methods publicly accessible, as is the case for the ODSAdapter, 
but be aware that this is currently adapter specific. See 
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org.eclipse.mdm.api.odsadapter.RelationTest for an example. Please note that you 
can only modify mutable relations (in the MutableStore), e.g. no parent child 
relations. 

11 Troubleshooting 
Look into the Logfiles: 
 

● Glassfish: 
$glassfish_root/domains/domain1/logs/server.log 

● Derby DB for User Preference Service: 
$glassfish_root/databases/derby.log 

● Peak ODS Server: 
$peakodsserver_root/logs/ 
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